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Введение
В условиях быстрого развития сети Интер-

нет все более актуальной становится задача по-
строения сложных сервисных и информацион-
ных систем. Программное обеспечение таких
информационных систем должно отвечать ряду
критериев: организация развитых online серви-
сов для пользователей, индивидуальный подход
к пользователям ресурса, управление системой
�на лету�, включая возможность легко уточнять
описания предметной области, внедрять новые
компоненты и сервисы.

В последнее время для решения таких за-
дач предлагается мультиагентный подход. Та-
кой подход позволяет описывать сложную сис-
тему как сеть небольших активных программ-
ных объектов � �агентов�. Агенты должны
иметь способность использовать формализо-
ванное описание понятий и отношений пред-
метной области � �онтологию� � в соответствии
с некоторыми универсальными правилами и
стратегиями поведения. Такой подход позволяет
строить по настоящему открытые и самоорга-
низующиеся системы.

Основой создания таких систем может
стать технология открытых мультиагентных си-
стем (ОМАС) корпорации MagentA, разраба-
тываемая в течение последних лет [1]. Так, на-
пример, для разработки мультиагентных при-
ложений в сети Интернет можно удобно и эф-
фективно использовать SB MagentA Engine (см.,

например, [2]).
Однако программирование мультиагент-

ных Web-приложений имеет целый ряд особен-
ностей:

- специфика мультиагентного подхода требу-
ет использования специальных языковых
средств (например, управление параллельными
процессами, управление онтологиями) для эф-
фективного и выразительного описания;

- необходимо разрешить вопросы безопасно-
сти, устойчивости и расширяемости МАС для
того, чтобы эффективно использовать ее в Ин-
тернет приложении на стороне сервера.

В данной статье мы рассмотрим основные
этапы построения мультиагентного Интернет-
приложения с помощью ядра SB MagentA
Engine. При этом мы обратим особое внимание
на языковые средства и визуальные инструмен-
ты, применяемые для реализации различных эта-
пов мультиагентной системы.

Постановка задачи
Итак, продемонстрируем каким образом

пользователи и программисты могут конструи-
ровать мультиагентное приложение с помощью
ядра MagentA Engine и конструктора Ontology
Toolkit. В качестве простого примера выберем
простую систему мультиагентного планирова-
ния работ. Пусть в нашей системе будет только
два типа агентов:

- агент программиста;
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- агент проекта.
Задача этих агентов � провести перегово-

ры и установить взаимовыгодное соответствие
(�matching�) между проектом и программистом.
В этом примере мы намеренно будем избегать
использования уже готовых протоколов, страте-
гий агентов и других стандартных средств для
того, чтобы рассмотреть все этапы разработки
нового приложения. Однако при этом, мы упро-
стим некоторые этапы разработки (оставив за
кадром web-интерфейс, работы с базой данных,
упростим структуру онтологии).

Создание проекта
После открытия MagentA Ontology Toolkit,

необходимо создать новый проект, в котором
мы будем разрабатывать все компоненты нашей
системы. Проект � это коллекция файлов ис-
ходных текстов онтологии, шаблонов интер-
фейса, настроек интерпретатора ядра и т.п. Для
создания проекта необходимо выбрать File →
New Project и выбрать Simple Project. В этом
случае, создастся пустой проект, в котором мы
сможем �с нуля� начать конструирование. В
проекте будет создана единственная сеть (main)
в единственном файле.

Разработка протокола переговоров
С разработки протокола переговоров начи-

нается первый этап разработки МАС � описа-
ние архитектуры мультиагентного сообщества.

На этом шаге необходимо разработать и
сконструировать протокол переговоров агентов.
Протокол описывает формальные правила, ко-
торым должны следовать участники переговор-
ного процесса (использующие разные страте-
гии), чтобы их сообщения были понятны каж-
дой стороне. В мультиагентном ядре описание
протокола включает:

- имя протокола;
- имена сторон протокола (поддерживаются

только двух сторонние протоколы, более слож-
ные переговоры на данном этапе должны быть
представлены как комбинация двухсторонних
протоколов);

- сторона, которая начинает переговоры;
- типы, атрибуты и порядок сообщений, ко-

торыми могут обмениваться агенты.
Для создания протоколов переговоров име-

ется специальный мастер. Для его активации

необходимо выбрать команду Insert → New
Protocol (эта команда доступна только при от-
крытом файле онтологии).

После того как мастер создаст протокол и
его две стороны, онтолог должен визуально со-
здать все сообщения и связать их отношениями
следования (с помощь, команды Create Link кон-
текстного меню).

В нашем случае ограничимся следующим
протоколом:

- Агент заказа (проект) обращается с пред-
ложением (Query) к агенту ресурса (програм-
мист). Это сообщение имеет единственный ат-
рибут � указатель на экземпляр онтологическо-
го класса, который предлагает для �матчинга�
агент заказа (в нашем случае � указатель на
объект �проект�).

- Агент ресурса отвечает согласием
ResourceYes или отказом ResourceNo.

Конечно, в таком простом варианте прото-
кол не сильно отличается по возможностям от
традиционных средств поддержки полиморфиз-
ма в объектных языках (например, виртуальные
функции). Но в более сложных ситуациях (цик-
лические переговоры с взаимными подвижка-
ми, многовариантные переговоры), такая схема
протоколов имеет существенные преимущества,
явно публикуя доступную всем агентам систе-
мы схему переговоров.

Проектирование классов агентов
Для описания архитектуры мира мульти-

агентного сообщества необходимо определить

Рис.1. Список доступных классов
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классы агентов-участников. Агент в мультиаген-
тном ядре � это объект специального типа
CAgentClass (реализованный на C++), который
имеет следующие специальные возможности и
свойства:

- Имеет возможность владеть личными ин-
струментальными объектами и стратегиями в
своей сети. Специальным образом реализована
поддержка объектов-соединителей (sockets), ко-
торые позволяют агентам инициировать перего-
воры.

- Имеет указатель на экземпляр онтологичес-
кого объекта, которого он представляет. Разде-
ление агента программиста и объекта �Програм-
мист� имеет важное методическое значение.

- Является потомком онтологического класса

и поэтому сам может иметь атрибуты, связи и т.п.
Программисты и онтологи не обязаны со-

здавать всех своих агентов на базе CAgentClass.
При необходимости, программист может сам с
помощью языка семантических сетей и сцена-
риев сконструировать агентов из онтологичес-
ких классов и других объектов. Однако управ-
ление такими агентами � более сложный про-
цесс, который выходит за рамки этой статьи.

Агентов на основе CAgentClass можно со-
здавать с помощью удобного мастера. Находясь
на сети main, выберем команду File → New
Agent.

Как видно на рисунке, при создании агента
можно определить его основные параметры:

- имя;
- имя его личной (implementation) сети;
- имя онтологического класса, который пред-

ставлен агентом (если необходимо);
- список протоколов, по которым агент мо-

жет инициировать и принимать переговоры.
После завершения конструирования мож-

но увидеть следующие изменения в сетях, ука-
занные на рисунке:

Аналогично можно создать агента програм-
миста с его онтологическим классом (не забыв
указать, что он поддерживает сторону Resource
в протоколе Matching, причем может принимать
входящие запросы на переговоры).

В нашей системе агенты будут иметь всего
по два строковых атрибута:

Рис.2. Протокол переговоров

Рис.3. Создаем агента проекта с помощью
мастера

Рис.4. Определяем протоколы, по которым
агент может переговариваться
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- AgentName � в этом атрибуте будет указано
имя агента для идентификации в логе и отладки.

- Condition � этот очень важный атрибут бу-
дет хранится условие (в виде сценария) приня-
тия решения о матчинге. Значение этого атрибу-
та будет интерпретироваться �на лету� страте-
гией агента.

После того, как классы агентов введены,
необходимо определить организацию агентов.
Простейшая организация агентов � неупорядо-
ченный список агентов, который может наблю-
даться любым агентом с соответствующей син-
хронизацией (COntHive).

Заполнение этого списка будем проводить
при запуске системы с помощью специального
автоматически стартующего инициализирующе-
го сценария (Automatic Script).

Проектирование онтологии
предметной области
Онтология � это концептуализация пред-

метной области, доступная для работы агентам.
В MagentA Engine онтология задается как семан-
тическая сеть.

Мастер агентов уже создал классы Project
и Programmer, которые будут являться основой
нашей онтологии. Зададим теперь набор атри-
бутов этих классов. Пусть проект имеет:

- целочисленный атрибут Complexity (слож-
ность проекта с минимальным значением 0 и
максимальным 9);

- целочисленный атрибут Price (стоимость
проекта).

А программист имеет:
- строковый атрибут Language (язык програм-

мирования, которым владеет).
Кроме того, пусть проект будет связан с

программистом отношением �матчинга�. В ядре
MagentA Engine существует несколько способов
представления отношений. В нашем случае наи-
более просто воспользоваться однонаправлен-
ным ссылочным атрибутом (Link Attribute). На-
зовем этот атрибут Pair (�Пара�).

На этом проектирование онтологии можно
закончить и перейти к созданию сцены.

Конструирование сцены
на основе онтологии предметной
области и архитектуры мира
До того как мы перейдем к описанию кон-

струкций агентов, создадим описание сцены (эк-
стенсионального списка всех экземпляров аген-
тов). Это даст нам возможность удобно отлажи-
вать систему при конструировании агентов. Для
этого дважды щелкнем по объекту InitScript сети
main и внутри его сценария OnExecute опишем
следующий сценарий:

var Agent1=ProjectAgent.Create();
pAgent1.AgentName=»Engine
    Development»;
pAgent1.Condition=»return
    Pair.Language==\»C++\» ||
    (Pair.Language==\»Java\»);»;
pAgent1.Object.Price=500;
pAgent1.Object.Complexity=3;
theHive.Add(pAgent1);

В этом сценарии мы выполняем:
- создание агента (автоматически создастся

его онтологический объект);
- инициализацию атрибутов агента

(AgentName и Condition);
- инициализацию атрибутов онтологическо-

го объекта агента (Price и Complexity);

Рис.5. Агент и его онтологический класс
Рис.6.  Личная сеть агента с указателем на

самого агента и исходящим сокетом

Рис.7. Агенты со всеми атрибутами, �ульем� и
инициализирующим сценарием
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- добавляем агента в hive.
В реальных приложениях чтение сцены

почти всегда осуществляется по результатам зап-
роса к базе данных (а сам запрос зачастую фор-
мируется в результате анализа онтологии). Од-
нако в нашем случае проинициализируем �вруч-
ную� второго агента:

var pAgent2=ProjectAgent.Create();
pAgent2.AgentName=»Engine
    Development»;
pAgent2.Condition=»return
    (Pair.Language==\»Java\»);»;
pAgent1.Object.Price=100;
pAgent1.Object.Complexity=1;
theHive.Add(pAgent1);

Совершенно аналогично можно произве-
сти создание других агентов (агентов програм-
мистов):

var
      pAgent3=ProgrammerAgent.Create();
pAgent3.AgentName=»Jhon»;
pAgent3.Condition=»return
    Pair.Price>200 &&
    Pair.Complexity<3;»;
pAgent3.Object.Language=»C++»;
theHive.Add(pAgent3);

var
      pAgent4=ProgrammerAgent.Create();
pAgent4.AgentName=»Bob»;
pAgent4.Condition=»return
    Pair.Complexity<=1;»;
pAgent4.Object.Language=»Java»;
theHive.Add(pAgent4);

var
    pAgent5=ProgrammerAgent.Create();
pAgent5.AgentName=»Smith»;
pAgent5.Condition=»return
    Pair.Price>=400;»;
pAgent5.Object.Language=»Java»;
theHive.Add(pAgent5);

В конце инициализации необходимо выпол-
нить для каждого созданного агента команду

подтверждения создания. Эта команда синхро-
низации разрешает агентам начать исполнение
сценарием. Если бы агенты начинали работать
немедленно после создания (а работают агенты
параллельно и автономно), то первые добавлен-
ные агенты увидели бы меньше агентов в спис-
ке, чем последние.

Обратите внимание, что атрибут Condition
является обычным строковым атрибутом. А зна-
чит его значение тоже может хранится в базе
данных и редактироваться пользователем. Таким
образом пользователи сами могут задавать пра-
вила своему агенту. Так в нашем примере про-
граммисты задали следующие ограничения:

- Bob выполняет только самые простые про-
екты Pair.Complexity<=1.

- Smith берется только за дорогие проекты
Pair.Price>=400.

- Jhon берется за не самые дешевые, но и не
слишком сложные проекты Pair.Price>200 &&
Pair.Complexity<3

Безусловно, конечному пользователю удоб-
нее пользоваться визуальным конструктором
через Web-интерфейс, чтобы задавать правила
своему агенту. Для этого предусмотрен специ-
альный модуль, описание которого выходит за
рамки этой статьи.

После выполнения этих действий, можно за-
пустить проект на исполнение и убедиться в от-
сутствии синтаксических ошибок (Project→Run).
Но для того, чтобы проект реально начал работать
необходимо выполнить самый сложный этап �
сконструировать устройство агента.

Разработка конструкции
агента проекта
Начнем конструирование агента проекта с

вывода агентов лог сообщений традиционной
фразы �Hello, world�. Перетащим в личную сеть
агента Project (по умолчанию она называется
ProjectImpl) объект автоматический сценарий.
Назовем его MainScript и напишем там следую-
щие команды:

object MainScript
{
  type=»CNodeAutoScript»;
  script OnExecute
  {
    dump.Trace(«Project: Hello
    World! I am the agent»+

Рис.8. Атрибуты классов Project и Programmer
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    theAgent.AgentName);
  }
}

Автоматический сценарий запустится пос-
ле команды Commit (Вы можете убедиться в этом
сами, расставив команды dump.Trace в тексте
сценария InitScript, который мы создали в пре-
дыдущем разделе). После запуска проекта оба
агента должны отрапортовать о своем создании
в проколе работы ядра:

Service �NetLoader�: initializing
Project: Hello World! I am the agent: Engine
Development
Project: Hello World! I am the agent: Web
Development
Service �NetLoader�: initialization complete
Обратите внимание, что все действия и пе-

реговоры агентов, которые были созданы и воз-
буждены в автоматических сценариях, происхо-
дят в рамках инициализации ядра. Это очень
важно для реальных веб-приложений � пока не
закончится волна переговоров, возбужденных
стартом системы, не будут приниматься  запро-
сы удаленных пользователей. Это решает мно-
гие проблемы синхронизации�

Описываем поиск партнеров
для матчинга агента проекта
Первое, что должен сделать агент проекта

� найти своих потенциальных �партнеров� для
матчинга (агентов программистов).

Однако сценарии агентов лучше всего пи-
сать так, чтобы они минимально зависели от
предметной онтологии. Поэтому не будем напря-
мую запрашивать агентов по именам, а обратим-
ся к средствам навигации по онтологии.

Первое, что нам нужно сделать � это найти
по экземпляру агента, который мы имеем в сети
класс нашего агента:

var pMyClass=theAgent.Prototype;

Далее найдем класс объекта в онтологии,
который мы представляем:

var pMyOntClass=pMyClass.ObjectClass;

После этого получим полный список атри-
бутов, которые имеет онтологический класс:

var pMyOntClassAttributes=
pMyOntClass.Attributes;

Теперь найдем в списке атрибутов атрибут,
который имеет объектный тип:

var pMyLink=pMyOntClassAttributes.
Find(@A.TypeName=="object");

Обратите внимание, что в последней кон-
струкции появился конструкт �@�, который не
имеет прямого аналога в C++ и Java. Это так на-
зываемое анонимное функциональное �замыка-
ние� (�closure�). Подобные конструкции актив-
но используются в смешанных (функциональ-
но-императивных) языках, например, lambda-
функции в Python, замыкания в Vault (см. [3]).
Когда условие предварили знаком �@�, то оно
не вычисляется, а передается как функция внутрь
функции Find. Функция Find применяет выра-
жение к каждому элементу последовательности
и найдет только те элементы, которые удовлет-
воряют условию. Таким образом, мы найдем
первый ссылочный атрибут.

И, наконец, получаем по указателю класс
объект, который может стать нашей �парой�:

var pMyPair=pMyLink.ObjectType;

Чтобы убедиться, что все прошло правиль-
но, выполним отладочный dump.Trace:

dump.Trace("My pair class is"+
pMyPair.Name);

Убедившись, что все работает правильно,
найдем теперь всех агентов в Hive, которые пред-
ставляют интересующий нас класс (программи-
сты) и �пробежимся� по их коллекции.

var MyPartners=main.theHive.
FindAll(@A.Prototype.ObjectClass==
pMyPair);
var nCount=MyPartners.Size;
for(var i=0;i<nCount;i++)
{
  var Partner=MyPartners[i];
  dump.Trace("My"+i+"potential
  partner is "+Partner.AgentName);
}

Теперь лог ядра должен включать список
всех потенциальных партнеров.

Конечно, онтологию большого приложения
нецелесообразно строить как точную копию это-
го простого примера. В реальном приложении
было бы целесообразно выделить базовые клас-
сы ресурса и заказа, реализовав в них отношение
�вступать в отношение матчинга с�. Потом, в по-
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томках этих классов можно было означить это
отношение конкретными указателями на классы.

В этом случае, информацию о правилах
соединения различных классов и их потомков
знали бы не только сами агенты и программист,
но и Ontology Toolkit, который может использо-
вать эту информацию для работы с библиотеч-
ными онтологиями. Поскольку конструктор сам
следит за правильностью конструирования как
онтологий, так и сценариев, работа с такими
онтологиями доступна менеджерам и экспертам.

На рис.9. показан экран при работе с онто-
логией мультиагентного интернет магазина.

Интерпретация агентом проекта
сценария проверки
условия на лету
Теперь агент должен принять решение:

инициировать переговоры с потенциальным
партнером или нет. В нашем случае агент ис-
пользует для этого условие, заданное его пользо-
вателем:

var dynscript=
  Classes.CDynScriptContext();
dynscript.Pair=Partner.Object;
var Result=
   dynscript.Execute(theAgent.Condition);
if(Result)
{
  dump.Trace("I like him!");

}
else
{
  dump.Trace("I do not like him!");
}

Таким образом, стандартный класс
CDynScriptContext позволяет задать набор име-
нованных параметров (�Pair� � объект нашего
найденного партнера-агента). В результате ин-
терпретации и исполнения этого сценария �на
лету� агент проверяет условие.

Инициирование и проведение
переговоров со стороны
агента проекта
Инициирование и проведение переговоров

достаточно простой процесс, который предпола-
гает использование следующих команд сокетов:

- Соединить � OutSocket.Connect(Partner).
Операция возвращает коммуникационный сокет
для обмена сообщениями.

- Спросить � sock.Ask(MessageClass,
Attribute1, Attribute2). Операция посылает сооб-
щение, ждет ответа и возвращает ответ.

- Сказать � sock.Ask(MessageClass,
Attribute1, Attribute2). Операция посылает сооб-
щение (но ответа не ждет).

- Подождать сообщения �
sock.WaitForMsg(MessageClass). Операция ждет
ответа.

Рис.9. Запущенная система электронного магазина с �полкой�
предопределенных базовых объектов на заднем плане
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- Отсоединиться � sock.Disconnect(). Соеди-
нение разрывается.

Таким образом, в нашем случае сценарий
переговоров будет выглядеть так:

if(Result)
{
dump.Trace("I like him!");
var sock=
    OutSocket.Connect(Partner);
if(sock)
{
var Reply=
    sock.Ask(Matching.Query,
    theAgent.Object);
if(Reply.Prototype==Matching.ResourceYes)
{
dump.Trace("My partner AGREED!");
dump.Trace("Link established:
  "+theAgent.AgentName+"
  "+Partner.AgentName);
}
else
{
dump.Trace("My partner DISAGREED.");
}
sock.Disconnect();
}

Если мы запустим приложение прямо сей-
час и проанализируем лог, то убедимся, что про-
изошла взаимная блокировка � агент послал со-
общение, а ответа нет. В этом случае система
исполнения отслеживает эту ситуацию и преры-
вает исполнение переговоров (если нет других)
скриптов, которые могут продолжить работу.

Если бы переговоры проводились по зап-
росу удаленного пользователя, то в этот момент
очистились бы все ресурсы контеста памяти и
закрылись транзакции СУБД. При этом запрос
каждого удаленного пользователя обрабатывает-
ся в отдельном контексте и удаленный пользова-
тель практически не имеет шансов �обрушить�
систему. Однако такой подход накладывает це-
лый ряд ограничений на стиль программирова-
ния. Самое главное из них � агенты из разных
контекстов не могут видеть друг друга напрямую.

Конструирование агента
программиста
Реализация пассивного агента программи-

ста гораздо проще, чем реализация предыдуще-
го агента. Единственное и главное отличие в том,
что этому агенты не нужно запускать собствен-

ный автоматический скрипт, а достаточно ждать
события прихода запроса на соединение (в ин-
терактивном режиме). Это событие связано с
объектом �слушающий сокет�, который был со-
здан в теле агента программиста мастером. Вста-
вим в него реагирующий сценарий следующим
образом.

object InSocket
{
type="CCommListeningSocket"»;
Agent = [object theAgent];
ProtocolSide =
  [object Matching.Resource];
script OnAccept
{
var sock=Trigger;
var pMsg=
  sock.WaitForMsg(Matching.Query);
var pObj=pMsg.Object;

var dynscript=
  Classes.CDynScriptContext();
dynscript.Pair=pObj;
var Result=
   dynscript.Execute(theAgent.Condition);
if(Result)
  sock.Say(Matching.ResourceYes);
else
  sock.Say(Matching.ResourceNo);
  sock.Disconnect();
}
Специальный идентификатор Trigger обо-

значает параметр (обычно �возбудитель�) собы-
тия. В случае события OnAccept таким �возбу-
дителем� является коммуникационный сокет, че-
рез который можно осуществлять обмен сооб-
щениями.

Заключение
Итак, мы полностью завершили простей-

шее мультиагентное приложение. Если мы за-
пустим его на исполнение, то увидим, как аген-
ты находят друг друга и устанавливают соеди-
нения в процессе переговоров.

На этом примере можно выделить некото-
рые ключевые особенности инструментальных
средств ядра и стиля программирования аген-
тов на базе ядра:

1. Знания предметной области можно фор-
мулировать независимо от реализации системы
в виде онтологии предметной области.

2. Сценарии агентов можно писать незави-
симо от предметной области с помощью опера-
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ций навигации по онтологии.
3. Сценарии агентов могут включать дина-

мические правила, загруженные из базы данных
или сконструированные на лету.

4. Протоколы переговоров позволяют от-
дельно описать формальную схему процесса
переговоров. Если два агента будут следовать
этой схеме, то они смогут работать совместно,
независимо от типа сценариев, которые ими уп-
равляют.

5. Для описания поведения агентов очень
удобно использовать логику параллельных сце-
нариев. Мультиагентное ядро предоставляет эф-
фективный и прозрачный механизм диспетче-
ризации таких сценариев.

6. Функционально-императивное програм-
мирование позволяет удобно и наглядно описы-
вать навигацию и изменение онтологии.

7. Ядро использует технологию контекстов
(виртуальных �комнат�) в рамках которых аген-
ты производят переговоры. Если происходит
ошибка, то все ресурсы контекста освобожда-
ются и не влияют на работу ядра. Такой подход
также позволяет очень эффективно управлять
распределением памяти. Однако при этом нуж-
но следить, чтобы агенты осуществляли пере-
говоры отдельными независимыми блоками (в
ответ на запрос пользователя или изменение в
БД) длительностью не более 10 секунд. В этом
случае ядро нагружается наиболее эффективным
образом.

Отметим также некоторые правила, кото-
рые необходимо учитывать при разработке бо-
лее сложных онтологий:

1. При соблюдении пунктов 1, 2 и 3 архи-

тектурный уровень и фундаментальные мета-
концепты онтологии можно отделить в отдель-
ную библиотеку. В этом случае менеджер смо-
жет управлять системой только на уровне пред-
метной области и простого редактора правил
агентов.

2. При создании приложений необходи-
мо уделять внимание разделению отдельных
слоев приложения. В нашем случае, были пра-
вильно выделены в отдельную сеть элементы
конструкции агента. Но онтология и структу-
ра мира агентов находилась в одной сети, а это
может быть неудобно для больших систем. Для
конструирования многослойных сетей (с го-
ризонтальными-внутрислойными и верти-
кальными-межслойными связями) удобно
применять специальный �объект-проекцию�
узла сети на другой слой).
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